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NEW QUESTION 1
- (Exam Topic 1)
You need to design the resort portal to meet the business requirements. Which data source should you use?

A. Microsoft Excel

B. Azure SQL Database
C. SQL Server

D. Common Data Service

Answer: A

NEW QUESTION 2

- (Exam Topic 1)

You need to design the chat solution to answer the inquiry from Guestl.

Which three components can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Variables

B. Escalations
C. Smart match
D. Synonyms
E. Topics

Answer: ACD

Explanation:

Scenario: Guestl inquires about snow conditions several times during each day of their stay.

Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.

Synonyms allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even
smarter.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 3

- (Exam Topic 1)

You need to design the resort portal's email registration process.

Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement Solution

Implement the invitation code v

redemplion process Auto-populate the invitation code field on the sign-in screen from the email link
Embed the imatation code in the email ink URL
Send the customer their usemame and temporary password in the email link.

Validate the user's email v
Two-factor authentication

Azure Active Directory authentication

Social prowider sign-in

Invitation code sign-up

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Requirement Solution
Implement the invitation code v
redemption process | Auto-populate the invitation code field on the sign-in screen from the email link.
| Embed the invitation code in the email link URL. |
Send the customer their username and temporary password in the email link.

Validate the user's email v

Two-factor authentication

Azure Active Directory authentication
| Social provider sign-in

Invitation code sign-up |
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NEW QUESTION 4

- (Exam Topic 2)

You need to set up the new service request completion process.

Which two components should you include in the solution? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. connection reference

B. business process flow
C. Power Automate flow
D. connection

Answer: AC

Explanation:
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/create-connection-reference

NEW QUESTION 5
- (Exam Topic 2)
You need to implement the requirement for the VP of sales. What should you do?

A. Use a test account with a base security role with QV security added.
B. Add the System Administrator security role to your user account.

C. Use atest account with only QV security added.

D. Add QV security to your user account.

Answer: A

Explanation:

A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering.

Currently, testing the new QV functionality outside the development environment is not possible due to corporate security policies requiring the same security role
across all environments.

Note: One of the security best practices in Dynamics 365 is to use the base security role as a baseline and apply that role to all Users. The base security role will
include all the common/basic permissions that are required to have access to the system.

To set up the base security role for the first time

2 Ccreate a new empty security role.

> add the minimum privileges required to access the system.
> add the privileges required for the basic functionalities.

> test the role with the test user account.

> add the permissions to the entities that all users can access (e.g. reference data).
Reference: https://linnzawwin.blogspot.com/2020/07/minimum-privileges-required-to-log-in.html

NEW QUESTION 6
- (Exam Topic 2)
You need to coordinate updates and deployment for managed solutions containing completed work without disrupting the system.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
Deployment option for changes to an unrelated table

Deploy a patch with the changes made from the current solution
Deploy a full copy of the new solution with the changes using the upgrade option.
Deploy a full copy of the current solution with the changes using the upgrade aption.

Deployment option for automation enhancements

Deploy the new solution and then deploy a full copy of the onginal solution. Use the upgrade option for both deployments.
Deploy a full copy of the original solution and then deploy the new solution. Use the upgrade option for both deployments.
|Deploy a full copy of the oniginal solution using the upgrade option. Then, deploy the new solution by using the update option.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Deploy a patch with the changes made from the current solution. Scenario:

The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live
date without the other shared components.

Box 2: Deploy a full copy of the original solution using the upgrade option. Then, deploy the new solution by using the update option.

Scenario: All components required for the verification process must be included in a new solution. Corporate security requires that deployments to non-
development environments must be automated using

service accounts.

Managed solutions are used to move customizations from the development environment to other higher-level environments. These solutions are created and
maintained by the power users and provided to internal IT for deployment when they are ready.

Note:

Upgrade This is the default option and upgrades your solution to the latest version and rolls up all previous patches in one step. Any components associated to the
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previous solution version that are not in the newer solution version will be deleted. This is the recommended option as it will ensure that your resulting configuration
state is consistent with the importing solution including removal of components that are no longer part of the solution.

Update This option replaces your solution with this version. Components that are not in the newer solution won't be deleted and will remain in the system. This
option is not recommended as your destination environment will differ in configuration from your source environment and could cause issues that are difficult to
reproduce and diagnose.

Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/update-solutions

NEW QUESTION 7

- (Exam Topic 2)

You need to add the missing components to the Verification Process Automation solution. Which two components should you add? Each correct answer presents
a complete solution. NOTE: Each correct selection is worth one point.

A. Service Request statuscode field

B. Dataverse connection reference

C. Qualification statuscode field

D. On-premises data gateway reference
E. Outlook connection reference

Answer: CE

Explanation:

C: A service request can have one or more Qualification records associated with it. E: The new process for completing a service request must automate the
following:

« Set the Service Request record status to Complete when work on all Qualification records is finished.

» Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending
on the verification.

NEW QUESTION 8

- (Exam Topic 2)

You need to configure a Power Automate flow to send the email with the results to the client. What should you use? To answer, select the appropriate options in
the answer area.

NOTE: Each correct selection is worth one point.

Requirement Control
Process qualification records for a v
service request. Citeh

Condition

Apply to Each

Evaluate a qualification. v

Do until
Condition
Apply to Each

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Apply to each

You can use the Apply to each action to process a list of items periodically. Box 2: Do until

The Do Until control in Power Automate is a loop that repeatedly forces an action until a certain condition becomes true.

Reference: https://docs.microsoft.com/en-us/power-automate/apply-to-each https://blog.enterprisedna.co/do-until-loop-control-in-power-automate/

NEW QUESTION 9

- (Exam Topic 3)

A company plans to implement chatbots by using Power Virtual Agents. The company has the following requirements for the bots:

* Users in the accounting department must be able to create a bot for frequently asked questions.

» The support desk users must be able to use the bot.

The users must not be able to change environment parameters in the Microsoft Power Platform environment. You need to configure the permissions for the bots.
Which actions should you implement? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area
Requirement Action
Users can créate a bot I Assign users the Maker permissions .
Assign Users 10 a secunty role
Share the bot with a secunty groug
Asugn users the Maker permissions,
Assign users the System Admirustrator role
Support desk users can use the bot | Share the bot with a secunity group .
-'d.'n.l;n users 10 & secunty ole
Share the bot with a secunty group.
Assign users the Maker parmisaions
Assign users the System Adminestrator role
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Requirement Action

Users can create a bol I Assign users the Maker permissions .

Assign users 10 a secunty role

Share the bot with a secunty group
SN USCTS 1
Assign users the System Adminastrator role

Support desk users can use the bot [ Share the bot with 3 secunty group .
ASTHON USers 10 & secunty 1ole
Assign users the Maker permissons

ALTION WSErs the System Admunestratorn role

NEW QUESTION 10

- (Exam Topic 3)

You create a canvas app that uses data from a Microsoft SQL Server database.

You use a dataflow to move some of the data from the database to Microsoft Dataverse. Users will filter the data by using the app.

You need to filter data in the dataflow and in the canvas app.

Which tools should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You
may need to drag the split bar between panes or scroll to view content.

Tools Answer Area
Power Fx Requi . Yool
Power Query Filter data in the dataflow.
Filter data in the canvas app
T-SQL
Kusto ’
A. Mastered

B. Not Mastered
Answer: A

Explanation:

First Box: Power Query

To filter data in a dataflow, you should use Power Query. Power Query is a data connection tool that is part of the Microsoft Power Platform, which allows you to
connect to various data sources, transform, and load data into other applications such as Power Bl, Excel, and Dataverse. It is a functional, case-sensitive, and
data-transformation language that enables you to discover, connect, combine, and refine data sources to meet your business intelligence needs.

Power Query allows you to filter data by using its built-in functions and operators. You can filter data by using the filter, sort, and group by functions, as well as by
using custom formulas and conditions. You can also use the advanced editor to write complex queries using M code, which is the underlying language used by
Power Query.

Reference: https://docs.microsoft.com/en-us/power-query/ https://docs.microsoft.com/en-us/power-query/transform/filter-rows-by-condition

2nd Box: Power Fx

To filter data in a canvas app, you should use Power Fx. Power Fx is a no-code, low-code, and code-based platform that enables you to build custom business
logic and automate workflows in your Power Platform apps. It allows you to create custom formulas and expressions in the app using a functional language, which
allows you to filter data in the app.

Power Fx can be used to create custom formulas and expressions in the app which can filter data in the app by using its built-in functions and operators. You can
filter data by using the filter, sort, and group by functions, as well as by using custom formulas and conditions. You can also use the advanced editor to write
complex queries using Power Fx code.
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Reference: https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/power-fx-formulas

NEW QUESTION 10

- (Exam Topic 3)

You are creating tables for use with Microsoft Power components.

The display names of the tables must not be changed when the solution is promoted to the user acceptance testing environment.
You need to apply this restriction to the solution, Where should you make the changes?

A. Power Apps

B. Default solution

C. Segmented solution
D. Unmanaged solution
E. Managed solution

Answer: C

NEW QUESTION 12

- (Exam Topic 3)

You plan to create a dataflow to import data into Microsoft Dataverse by using Power Query. The dataflow has the following requirements:
* A table of aggregated data must be created in dataflow storage.

* A unique identifier must be created for the table.

You need to configure the dataflow.

Which solutions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection Is worth one point.
Answer Area

Requirement Solution

Table of aggregated data I hMerge query :\;-ﬂ
Fact table

Linked entity
Computed entity

Urigue identifier ! Key column - l
Pivot column
Alternate key

A. Mastered
B. Not Mastered

Answer: A
Explanation:
Answer Arca
Requirement Solution
Table of aggregated data | Merge query @
Fact table
] Merge query |
Linked entity

Computed entity

Urngque identinier ] Koy column st ]

FPivot column

Alternate key

NEW QUESTION 15

- (Exam Topic 3)

You set up a new instance of Dynamics 365 for Customer Service. Users report a variety of issues working with cases on mobile devices. You need to configure
the mobile app to be able to view cases. NOTE: Each correct selection is worth one point.
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Scenario Action needed

Users cannot see case records on mohile Y

devices. Configure mobile settings set on the case entity level
Configure mobile settings at the field level within the case form.

Configure a security role in the mobile permission set for appropnate users.

Users can open cases but cannot see the "'

subject of the case Configure mobile settings set at the case entity level
Configure mobile settings at the field level within the case form.

Configure a security role in the mobile permission set for appropriate users.

Users report that they cannot access the ‘ :

system from the Dynamics 365 mobile

30D Contigure mobile settings set at the case entity level,
Configure mobile settings at the field level within the case form

Configure a security rale in the mobile permission set for appropriate users

A. Mastered
B. Not Mastered

Answer: A

Explanation:

* 1. User is able to login but can't see Case Records --> "Configure Mobile Settings on Case Entity Level"

* 2. Users can open cases but cannot see the subject of the case - “configure mobile settings at the field level within the case form

* 3. User reports that they cannot access the system from Dynamics 365 mobile app --> Configure a security role in the mobile permission set of the appropriate
user

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/mobile-app/set-up-dynamics-365-for-phon

NEW QUESTION 17

- (Exam Topic 3)

A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams.

This app needs to be promoted to the user acceptance testing environment.

You need to complete the Microsoft recommended actions before you export the solution. Which two actions should you complete? Each correct answer presents
part of the solution. NOTE: Each correct selection is worth one point.

A. Write validation tests.

B. Set the Optimized embedding appearance field to true.
C. Publish all changes.

D. Run the solution checker.

E. Clone a solution.

Answer: DE

Explanation:

The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns.
After the check completes, you receive a detailed report that lists the issues identified, the components and code affected, and links to documentation that
describes how to resolve each issue.

The solution checker analyzes these solution components: Common Data Service plug-ins

Common Data Service custom workflow activities

Common Data Service web resources (HTML and JavaScript) Common Data Service configurations, such as SDK message steps

Reference: https://www.eimagine.com/ui/

NEW QUESTION 18

- (Exam Topic 3)

A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the
devices and then launch the apps to perform actions.

Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in
the future.

You need to configure the solution to prevent the reported security incidents. What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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Requirement Action

Prevent unauthonzed access to devices.

|

Set an inactivity limit in the user's group policy
Set a timeout in the Power Platform admin center
Configure access controls in Azure Active Directory

Configure a Power Automate flow to poll for user inactivity on the devices.

Prevent users from uploading a specific type of file. \ J

Enter the restricted file types in the SharePoint admin center
Enter the allowed file types in the Power Platform admin center,

Enter the restncted file types in the Power Platform admin center.

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Graphical user interface, text, application Description automatically generated
Box 1: Set a timeout in the Power Platform admin center.

To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain
signed in the application for the duration of session. The application signs out the user when the session expires. Users need to sign in with their credentials to

return to customer engagement apps.
Note: Configure session timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout

> In the Power Platform admin center, select an environment.
> Select Settings > Product > Privacy + Security.

> Set Session Expiration and Inactivity timeout. These settings apply to all users. Box 2: Enter the restricted file types in the SharePoint admin center.

To block uploading of specific file types
> Go to the Settings page of the new SharePoint admin center,

> Select Sync.
Graphical user interface, text, application Description automatically generated

Sync

> Select the Block upload of specific file types check box.
> Enter the file name extensions you want to block, for example: exe or mp3.

D’ Select Save.
Reference:

https://docs.microsoft.com/en-us/power-platform/admin/user-session-management https://docs.microsoft.com/en-us/onedrive/block-file-types

NEW QUESTION 21
- (Exam Topic 3)

You create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams. Users report that they are unable to view the app in Teams. You need to

ensure that users can access the app. What should you do?

A. Share the app with a security group by using the Maker portal.
B. Share the app with a security group in Teams.

The Leader of IT Certification

visit - https://www.certleader.com



CertLeader.m 100% Valid and Newest Version PL-200 Questions & Answers shared by Certleader

Toader of IT Cortifications https://www.certleader.com/PL-200-dumps.html (211 Q&AS)

C. Request that a tenant administrator pin the app to the app bar in Teams.
D. Publish the app by using the Maker portal.
E. Share the app with individual users by using the Maker portal.

Answer: C

Explanation:

When you create a Power Apps app for Microsoft Teams using Microsoft Dataverse for Teams, the app needs to be added to the app bar in Teams before it can
be accessed by users. This can only be done by a tenant administrator. To ensure that users can access the app, you would need to request that the tenant
administrator pin the app to the app bar in Teams.

Sharing the app with a security group by using the Maker portal (A) or in Teams (B) would allow users in that group to access the app, but they would still need to
be able to find and open the app.

Here are some references from Microsoft that may be helpful in understanding how to make Power Apps app available in Teams:

> Microsoft docs: Add a Power Apps app to a Microsoft Teams channel
> Microsoft docs: Pin a Power Apps app to the app bar in Microsoft Teams
> Microsoft docs: Distribute Power Apps for Microsoft Teams

NEW QUESTION 24

- (Exam Topic 3)

You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns
for users to enter their data. The form includes the following columns:

" Column Data tyEe
Country/region Choices (multi-select)
Passport ownership Lhoice (yes /no)
Passport expiration date Text

The form must do the following:

» The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column
must remain blank so that user can enter a value.

» The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column.

You need to configure the app with the least amount of effort.

What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Salution ¢oimpanerlE HArdvrer Area

LS e Solution CoMmBoRnent

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Graphical user interface Description automatically generated with low confidence

NEW QUESTION 26
- (Exam Topic 3)
A company plans to automate the following manual processes by using Power Automate. You need to identify Ul flow types for the two business processes.

Process | Time to Complete Comments

1 | 30 minutes The user's device must remain unlocked when the business process runs. The user will be reguired to leave their

[ device unallended in a secure setting while the Dusiness process runs so that the user can assist wath other

| eftorts

#3 MINULes The process must mun after normal business hours, The device that runs the business ProCess must remain

unlocked when the business process 1S not running

Which desktop flow type should you use? To answer, drag the appropriate desktop flow types to the correct business processes. Each desktop flow type may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Deslctop flow types Answer Area

tended Unanenced Businessprocess  Desktop flow type

The Leader of IT Certification visit - https://www.certleader.com



CertLeader.m 100% Valid and Newest Version PL-200 Questions & Answers shared by Certleader

Toader of IT Cortifications https://www.certleader.com/PL-200-dumps.html (211 Q&AS)

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, application Description automatically generated

NEW QUESTION 31

- (Exam Topic 3)

You configure an alert in Power BI.

You need to alert users when the value of a tile exceeds a threshold. To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Where should you configure the Power Bl alert so that it -
triggers the process? Power Bl

Common Data Service

Power Automate

Fower Bl admin portal

Who can see alerts configured for Power BI? v
The person who created the alert

The dashboard owner and the person who created the alent
Everyone who has access to the dashboard.

Everyone who has access to the Power Bl instance

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-bi/create-reports/service-set-data-alerts

NEW QUESTION 32

- (Exam Topic 3)

A company collaborates by using Microsoft Teams.

You must create a Power Apps app directly from within a Teams channel. The app will be used by members of the channel to manage sales orders.
You need to create the app by using Dataverse for Teams. How should you create the app?

A. Create a canvas app by using a Power Apps personal app in Teams.
B. Create a canvas app by using the App Studio app.

C. Use the Power Apps web designer.

D. Create a model-driven app by using the App Studio app

Answer: B

Explanation:

You can create, edit, and delete canvas apps in Teams.

Note: With Power Apps Studio embedded in the Power Apps app in Teams and the new built-in data platform providing an easy-to-use, editable data table, you
can quickly build apps based on custom data tables that are

Teams-specific and scenario-specific.

Reference: https://docs.microsoft.com/en-us/power-apps/teams/create-first-app https://docs.microsoft.com/en-us/power-apps/teams/create-apps-overview

NEW QUESTION 36

- (Exam Topic 3)

You deploy a Power Vitlu.il Agents chatoot that integrates with Dynamics 365 Omnichannel for Customer Service.

You observe that the chatbot is not able to recognize the questions asked by use's.

You need to ensure that the chatbot can respond to unrecognized questions. The solution must minimize administrative effort.
What should you do?

A. Add a fallback topic

B. Create new topics.

C. Create an entity.

D. Modify the Escalate system topic.

Answer: A

NEW QUESTION 38

- (Exam Topic 3)

A company is building a Power Virtual Agents chatbot.

Users in the accounting department require access to collaborate with the building of the bot. Users in the sales department require access to only chat with the
bot.
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You need to configure the bot.

Which sharing options should you use? To answer, drag the appropriate sharing options to the correct requirements. Each sharing option may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Sharing options Answer Area

ST Requ;re ment Sharing option

eaie v Haa sermi ovkiam e s
T TN e o |3 U aLLLrLTIRN I LWLl L

¢ i s

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Sharing options Answer Area

Requirement Sharing option

. raf 1 tha 5 A ire Aer art e
I & 'y, - P A - ol e SR ] BRI ] & (LRL

.

NEW QUESTION 42

- (Exam Topic 3)

You create a new independent software vendor (ISV) solution for a Power Apps app.

The Power Apps solution will be imported into multiple customer environments. The environments will have a large variety of solutions and publishers.
You need to avoid naming conflicts during solution import.

Which element should you configure?

A. Package type

B. Configuration page
C. Marketplace

D. Prefix

E. Version

Answer: D

Explanation:

A solution publisher includes a prefix. The publisher prefix is a mechanism to help avoid naming collisions. This allows for solutions from different publishers to be
installed in an environment with few conflicts. For example, the Contoso solution displayed here includes a solution publisher prefix of contoso.

Reference: https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm

NEW QUESTION 46

- (Exam Topic 3)

A company uses a model driven app.

The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a workflow that has a Change Status step. Does the solution meet the goal?

A.Yes
B. No

Answer: B

NEW QUESTION 50

- (Exam Topic 3)

A company has locations in the United States, Brazil, India. and Japan. The company conducts financial transactions in all of these regions.
Financial transactions in Brazil are going to stop, but the office will remain open.

Users must longer be able to create records associated with the Brazilian currency. Historical records must remain intact

You need to configure Microsoft Dataverse to meet the requirement

What should you do?

A. Rename the Brazilian currency.

B. Delete the Brazilian currency record.

C. Disable the Brazilian language pack

D. Deactivate the Brazilian currency record.

Answer: D
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Explanation:
You can't delete currencies that are in use by other records; you can only deactivate them. Deactivating currency records doesn't remove the currency information

stored in existing records, such as opportunities or orders. However, you won't be able to select the deactivated currency for new transactions.

Reference:
https://docs.microsoft.com/en-us/power-platform/admin/manage-transactions-with-multiple-currencies

NEW QUESTION 52

- (Exam Topic 3)

You use Power Virtual Agents to create a bot that will answer and transfer help desk calls.

You create topics that contain nodes and functions. The company has the following requirements for the bot:

* When a caller states the word issue, help, or problem, the bot must respond with the question. "How can we help you today?"

* When the bot responds with the question, "How can we help you today?", the bot must provide the caller with the choices of hardware, software or other
» When the caller asks a question, the bot must save the response so that it can perform an action on the

response.

You need to configure the bot.

Which nodes or functions should you use? To answer, select the appropriate options in the answer area.

Answer Arca

Requirement Node/Function

Caller states issue. help, or problem. Tngger phrase »
Question
Message
Action

Bot provides choices Question v
Action
1on
Message
Vanable

i

Responses are temporarily saved dentifier v
Action
Vanable
Tngger

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Answer Area
Requirement Node/Function

Caller states issue, help, or problem. Tngger phrase v

j Ingger phrase
Question
Message
Action

Bot provides choices Question

Action

L

Message

Vanable

Responses are temporarily saved dentifier v
Action
Vanable
Tngger

identifier

NEW QUESTION 55

- (Exam Topic 3)

A company has a portal. Users sign into the portal by using a social media account.

The company wants to replace the existing portal with a Power Apps portal. users must sign up for access to the portal by using a Microsoft account and a unique

invitation code that will be provided to the users.
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Leader of IT Certifications

You need to configure authentication for the home page.

Which values should you use? To answer, drag the appropriate values to the appropriate authentication settings. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Values Answer Area

=1

A. Mastered
B. Not Mastered

Answer: A
Explanation:

NO NO

NEW QUESTION 59
- (Exam Topic 3)

Authentication setting
Extemal signin

B ]
SEIET RS T AR

Value

A bank uses Power Bl visualizations to help determine whether they should loan money to a customer. The bank has three different visuals that are part of a
Power Bl report. The bank uses a set of four risk variables that indicate whether the customer is creditworthy.
You must create a mechanism so that bank employees can change the values of the four risk variables. Changes to the value of any variable must cause the three

visualizations to update.
You need to create the solution.

Which action should you perform? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
Requirement

Action

Update the visualizations when users change
the values of the risk variables.

|V
Embed a canvas app in a Power B! report.
Embed a Power Bl report in a modei-driven app.
Embed a model-ariven app in a Power Bl report.

Ensure that users can adjust the values of the

\4

four risk variables that contribute to a
customer’s credit risk.

Use Power Bl tiles.
Use Power Apps visuals,
Use the Power Bl service.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Embed a Power Bl report in a model-driven app

You can embed a Power Bl report in a model-driven app main form. Box 2: Use the Power Bl service.
The Power Bl cloud service works with Microsoft Dataverse apps to provide a self-service analytics solution. Power Bl automatically refreshes the app's data
displayed. With Power Bl Desktop or Microsoft Excel, Power Query for authoring reports and Power BI for sharing dashboards and refreshing data from model-

driven apps,

your users have a powerful way to work with your app's data.

Reference:

https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/embed-powerbi-report-in-system-form
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/use-power-bi

NEW QUESTION 63
- (Exam Topic 3)

A company plans to create an app by using Power Apps. The company has the following requirements:
* The app must be able to enter data into Microsoft SharePoint

» Users must be able to add the app into Microsoft Teams.

You need to recommend which app to create. Which type of app should you recommend?

A. model-driven app as a personal app
B. canvas app as a personal app

C. canvas app as a tab app

D. model-driven app as a tab app

Answer: B
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NEW QUESTION 66

- (Exam Topic 3)

A company uses Common Data Service to store sales data.

For the past few quarters, the company has experienced a decrease in sales revenue. The company wants to improve sales forecasting.

The company plans to use Al Builder to implement the solution. You select fields that will be used for prediction.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Export data from Common Data Service
into Microsoft Excel

Train the category classification Al model

by using Common Data Service data @

Train the Al model by using data
exported to Microsoft Excel

Publish the Al model

Use the model with Power Apps

Import the Al model analysis into
Commen Data Service

Train the prediction Al model by using
Common Data Service data

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, application Description automatically generated

Step 1:

Before you can use your prediction model, you have to train it to perform the way you want. Step 2:

After you train your model, publish it to make it available.

Publish your model when you want to make it available to users in your Power Apps environment. Step 3: Use the model with Power Apps
Reference:

https://docs.microsoft.com/en-us/ai-builder/prediction-train-model

NEW QUESTION 67

- (Exam Topic 3)

A company is creating a canvas app and a model-driven app to manage their customer accounts.

The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.

You need to configure the scope for the business rules.

Which scope should you use? To answer, drag the appropriate scopes to the correct business rules. Each scope may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Scopes Answer Area
All forms | Business rule Scope

: Business Type column setting for customer size [
Specific form P 9

Account rating re-evaluation ‘
Table
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: Table

The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value.
Scope the business rule to Entity (Table). Box 2: Specific form

The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only.
For Model

The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:

If you select this item... The scope is set to...

Entity- The table and all forms for the table All Forms- All forms for the table

Specific form (account Main Form, for example) - Just that form

Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rules-recommendations

NEW QUESTION 72

- (Exam Topic 3)

You create a model-driven app for an automobile parts help desk.

A help desk agent uses a form to gather information about customers' automobiles in two custom tables. The names of the tables are Client and Automobile,
The form must prepopulate the following information about the customer from the client table:
* First name

* Last name

The agent must be able to type the following information about the automobile:

» Automobile make

» Automobile model

You need to implement the form.

What should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Requirement Configuration

Prepopulate chent information | Relationshg .

Dataflow

Relationship ___________|

Alternate key

Virtual table
Enter automobile informanton [abile g

LONNeCTor

Wl Automate Thow
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Requirement Configuration
Prepopulate client informaton l Relathonshag .
aflow
™ L) [
A Iter r*.}n?-g_i Yy
Virtual table
Enter automobile information Tabia -

nNeCTor

ower Automate flow

NEW QUESTION 73
- (Exam Topic 3)

You plan to create a dataflow by using Power Query to transform the data. You observe that some cells display an error instead of the expected data. You need to

obtain more details about the errors. What should you do?

A. Select the row that includes the cell with the error.
B. Use the Flow Checker.
C. Select the cell with the error.
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D. Use the App Checker.
E. Use the Advanced Editor.

Answer: C

Explanation:
When you select the cell with the error, a tooltip will appear with more details about the error. This will help you identify the cause of the error and take the
necessary steps to fix it.

NEW QUESTION 75

- (Exam Topic 3)

You are creating a business process flow for a Power Apps app. The business process flow must meet the following requirements:
» Must be available offline.

» Send an email to the team when a record is created. You need to set up business process flow.

What should you do? To answer, select the appropriate options in the answer area. Each correct selection is worth one point

Requirement Configuration

Ensure that the business process flow 15 referencing one Lable

[

Ensure that the busingss process flow 15 referencng two tables

Ensure that the business process flow 15 referencing one table per stage

SENd an email o the Tean

reale a requirad Columi

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Graphical user interface, text, application Description automatically generated

NEW QUESTION 76

- (Exam Topic 3)

You manage the Dynamics 365 Customer Service environment for an organization. Microsoft SharePoint will not be deployed in the environment for a year.
You need to integrate Microsoft Office 365 solutions with the Dynamics 365 instance to help the sales team with internal collaboration efforts.

Which three solutions can you currently implement? Each correct answer presents part of the solution. NOTE:

Each correct selection is worth one point.

NOTE: Each correct selection is worth one point.

A. Microsoft OneDrive for Business
B. Microsoft Yammer

C. Microsoft OneNote

D. Microsoft Skype for Business

E. Microsoft Exchange Online

Answer: BDE
Explanation:

References:
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/admin/add-office-365-online-services

NEW QUESTION 77

- (Exam Topic 3)

You plan to create user interface (Ul) flows to automate several web-based business processes that you currently perform manually. You need to ensure that
users can create and run web Ul flows.

Which three components must you install and configure on user's devices? Each correct answer presents part of the solution. NOTE Each correct selection is
worth one point.

A. Ul Flows application

B. Selenium IDE

C. Latest version of Microsoft Edge

D. On-premises data gateway

E. Latest version of Mozilla Firefox

Answer: ABC

Explanation:

Reference:
https://docs.microsoft.com/en-us/power-automate/ui-flows/setup

NEW QUESTION 82
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- (Exam Topic 3)
You are designing the organization structure for a company that has 5,000 users.
You need to configure security roles for the company while minimizing administrative effort. What should you do? To answer, select the appropriate options in the
answer area.
NOTE: Each correct selection is worth one point.
Requirement Action

Apply a secunty role to everyone in a business -

Assign the security role to the default business unit team.
Assign the security role individually to each user in the business unit
Create a new team. add the businéss unit users, and then assign the security role to the team.

Ensure an individual can see records in their -
current business unit and a child business unit.

Grant the user a secunity role from the child business unit.
Grant the user the Parent: Child Business Units secunty permission
Grant the user a secunty role from the root business unit

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Create a new team, and the business unit users, and the assign the security role to the team. Change the business unit for a team

Important
By changing the business unit for a team, you can remove all security role assignments for the team. At least one security role must be assigned to the team in the

new business unit.

> Select an environment and go to Settings > Users + permissions > Teams.
> Select the checkbox for a team name.

> Screenshot selecting a team.

> On the menu bar, select Change Business Unit.

> In the Change Business Unit dialog box, select a business unit. Enable Move records to new business unit to move to a new business unit. Select OK.

Box 2: Grant the user a security role from the child business unit.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/create-edit-business-units https://docs.microsoft.com/en-us/power-platform/admin/security-roles-

privileges

NEW QUESTION 87

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating Power Virtual Agents chatbot that captures demographic information about customers. The chatbot must determine the group a customer belongs
to based on their age. The age groups are:

> 0-17

> 18- 25

> 26-35

> 36-55

> 55-100

You need to configure the chatbot to ask a question that can be used to determine the correct age group. Solution: Use age for Identify in the question and then

add branches for each group that use conditional logic.
Does this meet the goal?

A. Yes
B. No

Answer: B

Explanation:

Instead, create a custom Age group entity and synonyms for each individual age in the corresponding item. Use Age group for Identify in the question.

The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to
teach the bot's language understanding model some domain-specific knowledge.

To do this, you need to create a custom entity. Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 90

- (Exam Topic 3)

A company is planning to create a Power Virtual Agents bot. The bot has the following requirements:

* The bot must provide address information for the company.

» The bot must be available from Microsoft Teams and from the internet website of the company. You need to configure the bot. Which component should you

use?
A. SKkill

B. Composer
C. Template
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D. Channel
Answer: D

Explanation:

To make the bot available from Microsoft Teams and from the company's internet website, you need to configure the channels for the bot. Power Virtual Agents
uses channels to connect the bot to different communication platforms such as Microsoft Teams, Skype, Facebook, and more. By configuring the appropriate
channels for the bot, you can make it available on those platforms and allow users to interact with the bot from those locations.

You can configure channels by going to the Power Virtual Agents portal, and then select the bot you want to configure. Then select the "Channels" tab, where you
can add the channels which you want the bot to be available on.

Reference: https://docs.microsoft.com/en-us/power-virtual-agents/channels-overview

NEW QUESTION 91

- (Exam Topic 3)

A customer has a support website that includes FAQ pages, knowledge articles, and support content. You plan to leverage an existing Power Virtual Agents bot to
enhance and streamline existing support

functionality for the existing support portal.

You need to create topics from existing website content. The process must minimize human errors during topic creation.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the

correct order.
Actions Answer area

i 1 [ "
4MLIEE A alalls T ' L& St ¥ o BTy
Haver over the QpIc and select the Automate icon,

Add selected topics to the chatbot.

1%

Enable the topics
enatie e tepics,

D
O

dentify the pre-filled trigger phases.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

> Select Suggest topics
on the Topics page to extract content from FAQ/support pages or online files.

> Add the suggested topics to your bot.

> Enable the topics.
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-create-topics-from-web

NEW QUESTION 95

- (Exam Topic 3)

A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to
send an escalation email.

The system must send an alert for all invoices that are seven days or more overdue. You need to configure the flow.

Which expression should you use?

rémail() = ‘OverdueDate’ »>= 7;

A, Tri

[N

"OverdueDate’ »= '7'?¥'TriggerEmail()":false

o

GreaterOrEquals(TriggerEmail()?[ 'OverdueDate’]: '7°)

[
[4 =5

A. Option A
B. Option B
C. Option C

Answer: C

Explanation:
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value'],’Ready to Generate’) Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

NEW QUESTION 100

- (Exam Topic 3)

A company plans to create two Microsoft Power Platform applications.

One of the applications requires a custom control layout without using code. The other application will be used primarily by external users.
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You need to create the applications.

Which application types should you use? To answer, drag the appropriate application types to the correct requirements. Each application type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Application types Answer Area

3Nvas app Requirement Application type

[ i Tl | f

ai dal 5 o Al LA, EYWAR WYL RGN L LR )

Cilel=0rmver A 1
L PLEL e

Aower Fanes norta
Wy Ayt S

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Application types Answer Area

-anvas app Requirement Application type

Custom control Jayout without coding f Canvas app

lemy |_ avtarnal ieere
WE0 O CXIEITIN LESETS

drear Banee nar s
FOWET Fages DOra

NEW QUESTION 103

- (Exam Topic 3)

You make the following customizations to a Microsoft Dataverse Environment
* Create a new table

» Add data to the new table.

* Delete an unused area from the site map.

The components must be transported to a different environment.

You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components. Each method may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

"ol g g Arwwer Ares

€ iyl ol Ptlg o Punad

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Alet bt o Ardwes Reea

C iermgainrag nl LE LW

NEW QUESTION 104

- (Exam Topic 3)

A company uses Power Apps with Microsoft Dataverse.

The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity.
You need to delete some auditing data.
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Which three deletion options should you use? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. by table

B. by record

C. between two specified dates
D. by column

E. older than a specified date

Answer: ACE

Explanation:

* A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to
the Power Apps portal, navigating to the Data tab, and selecting the table for which you want to delete the auditing data. You can then select the specific auditing
data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:

https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs

* C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Between two dates"
option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time period and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-audit-logs
* E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the
Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From there, you can select the "Delete" button, and select the "Older than a
specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older
than a certain date and not for the entire database. Reference: https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete-
audit-logs

It's always good to have a backup of Data before deletion and also check the retention period of the data you want to delete.

NEW QUESTION 109

- (Exam Topic 3)

A company uses Microsoft Teams. You plan to create a Power Apps app for Microsoft Teams. You need to determine the environment that will used by the app.
Which environment will the app use?

A. An existing Dataverse environment that you select.

B. An existing Dataverse for Teams environment that you select.

C. A Dataverse environment that is automatically created for the team.

D. A Dataverse for Teams environment that is automatically created for the team.

Answer: D

Explanation:

The Dataverse for Teams environment is automatically created for the selected team when you create an app or bot in Microsoft Teams for the first time or install a
Power Apps app from the app catalog for the first time. The Dataverse for Teams environment is used to store, manage, and share team-specific data, apps, and
flows. Each team can have one environment, and all data, apps, bots, and flows created with the Power Apps app inside a team are available from that team's
Dataverse for Teams database.

Reference:

https://docs.microsoft.com/en-us/power-platform/admin/about-teams-environment

NEW QUESTION 113

- (Exam Topic 3)

A company uses Power Apps.

Users must be able to view only the address1 columns in the Account table.

You need to ensure other address columns are not visible to users when creating views and filters. What should you do?

A. Disable the Search option for the columns.

B. Create business rules to hide the other address columns.

C. Delete the other address columns from the table.

D. Use column-level security to remove read access to all users.

Answer: D

NEW QUESTION 117

- (Exam Topic 3)

You ate a Dynamics 365 help desk administrator

You need to create a dashboard that displays information on help desk cases that ate handled each week. Which dashboard components should you use? To
answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area
Requirement

Component type

Add a stacked column char sharad with your 18am Personal chart

rea chart
o AT
Add a Microsoft Power Bl visuahzation erconal chart
@3 CHhart
m chant
Add a chart from a view that a3 user creates L

Add a doughnul chart that shows cases by ownet Personal chart

A. Mastered
B. Not Mastered

Answer: A

Explanation:

System Personal Personal

Personal System
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/basics/add-edit-power-bi-visualizations-da

NEW QUESTION 119

- (Exam Topic 3)

You are a Dynamics 365 Customer Service administrator.

Users report that the main form does not display data from other entities or allow them to edit data from other entities.

You need to embed information from other entities in the form and allow users to edit the data. Which actions should you perform? To answer, select the
appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement Action

Edit data v

Add a mobile form

Add a quick create form
Add a sub-grid

Add a virtual entity

View data 4

Add a reference panel
Add a quick view

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application, chat or text message Description automatically generated

Box 1: Add a quick create form

With quick create forms, your app can have a streamlined data entry experience with full support for logic defined by form scripts and business rules.

Box 2: Add a quick view

A quick view form can be added to another form as a quick view control. It provides a template to view information about a related entity record within a form for
another entity record. This means your app users do not need to navigate to a different record to see the information needed to do their work.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-quick-create-forms https://docs.microsoft.com/en-
us/dynamics365/customerengagement/on-premises/customize/create-edit-quick-v

NEW QUESTION 121

- (Exam Topic 3)

You are designing a chatbot for a sports outlet. You need to complete the chatbot.

Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.

NOTE Each correct selection is worth one point.
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Features Answer Area
_ Requirement Feature
Topics
le th t r t -world obj r topic
Enable the chatbot to relate to a real-world object or topic in a Feature
- dialog.
Entities
Define the path and triggers for a chatbot conversation. Feature
Variables
Implement conditional logic to dynamically route a conversation Feature
Flows across different paths
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Graphical user interface, text, application, email Description automatically generated

Box 1: Entities

Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs,
such as age, colors, numbers, and names.

With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.

Box 2: Topics

In Power Virtual Agents, a topic defines a how a bot conversation plays out.

You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.

A topic has trigger phrases — these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue — and conversation nodes —
these are what you use to define how a bot should respond and what it should do.

Box 3: Variables

Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.

For example, you can save a customer's hame in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.

Reference:

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-
topics

https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

NEW QUESTION 123

- (Exam Topic 3)

You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app. Where should you configure app permissions?

A. Security Roles

B. Manage Roles

C. Dynamics administration center
D. Dynamics 365 home

Answer: B

Explanation:

References:

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/customize/manage-access-apps-security-r Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles.
Users will have access to apps based on the security roles they're assigned to.

* 1. Go to Settings > My Apps.

* 2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles.

* 3. Enter the following in the Manage Roles dialog box:

a) App URL Suffix

b) Roles

c) Select Save.

* 4. Refresh the My Apps page.

* 5. Go to the Apps Being Edited view, and publish the app again. Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-app

NEW QUESTION 125

- (Exam Topic 3)

You plan to create a Power Virtual Agents bot. The bot has the following requirements:

» Ensure that user responses are available to any topic.

* Recognize a list of words from spoken language of users. You need to configure the bot.

Which features should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area

Requirement Feature

Liser responses are available to any topic Lr;|_;.t-_,_@_g_._._3£ able v_l
Entity
Bot vanable

Entity bl !

Recognize a list of words from spoken

language. Tomic
Vanable
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Requirement Feature
User responses are available to any topic Li!_’-"ﬂﬂl ‘ariable vl
Entity
;‘_"!!‘ LY

?

Recognize a list of words from spoken | Entity ]
language. | Topne
| Vanable

NEW QUESTION 127

- (Exam Topic 3)

A company uses a model-driven Power Apps app in a new environment. The base language is English. You need to configure French and Spanish.
Which configuration component should you use? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Requirement Configuration component

Allow a language to be used within an organization. v

Default language
Language collation
Language packs
LCID

Enable the languages. v

Browser
Environment
Power Apps app
Tenant

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Language packs

Before users can start using a Language Pack to display a language, the Language Pack must be enabled in your organization.
Box 2: Environment Enable the language

These settings can be found in the Microsoft Power Platform admin center by going to Environments > [select an environment] > Settings > Product > Languages.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/enable-languages

NEW QUESTION 128

- (Exam Topic 3)

You are using Power BI to build a dashboard for a company.

You must make the dashboard available to a specific set of users, including employees and five external users. The number of employees that require access to
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the dashboard varies, but usually less than 100. Employees and external users must not be permitted to share the dashboard with other users.
You need to share the dashboard with the employees and external users.
Which three actions should you perform? Each correct answer presents part of the solution. NOTE: Each correct selection is worth one point.

A. Create a dynamic distribution lis

B. Add all users to the distribution group and use the list to share the dashboard.
C. Sign into the Power Bl servic

D. Open the dashboard and select Share.

E. Enter the individual email address of internal and external users.

F. Sign into Power Bl Deskto

G. Open the dashboard and select Share.

H. Clear the Allow recipients to share your dashboard (or report) option.

I. Create a distribution grou

J. Add all users to the distribution group and use the list to share the dashboard.

Answer: BEF

Explanation:
Reference:
https://docs.microsoft.com/en-us/power-bi/collaborate-share/service-share-dashboards

NEW QUESTION 133

- (Exam Topic 3)

You plan on implementing complex business logic in Microsoft Dataverse tables by using Power Automate flows.

You realize that the functionality required to implement the business logic is not available in a Power Automate flow.

The new business logic must work in multiple Dataverse tables. In addition, the operation must return a value after it finishes and must be able to run from an
existing Dataverse action.

You need to recommend the method to implement the missing logic. What should you recommend?

A. Scheduled workflow
B. Bound action

C. Custom API

D. Unbound action

Answer: D

Explanation:
https://docs.microsoft.com/en-us/power-automate/dataverse/bound-unbound https://docs.microsoft.com/en-us/power-apps/developer/data-platform/custom-api

NEW QUESTION 135

- (Exam Topic 3)

You plan to create a canvas app.

The app requires a button on the data entry screen that users can select to send an email. You need to configure the app.
What should you create?

A. Business process flow

B. Azure Logic App

C. Power Automate cloud flow
D. Classic workflow

Answer: C

NEW QUESTION 138

- (Exam Topic 3)

A company uses a model-driven app. The app uses a workflow to send email. Emails are sent to new customers that enter an email address for the first time in the
app.

Customers report that they do not receive an email after entering an email address. You need to troubleshoot the issue.

In which order should you perform the actions? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

T ] HBrewrs e n

>

<

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Actions Angwer ared
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NEW QUESTION 140

- (Exam Topic 3)

You use Power Bl Desktop to configure Power Bl reports and dashboards.

You need to create a canvas app that displays account information and include the app in a Power Bl report. Which three actions should you perform? Each
correct answer presents part of the solution.

NOTE Each correct selection is worth one point.

A. Publish the report to the Power Bl service.

B. Connect to Common Data Service from Power Bl Desktop.

C. Connect Common Data Service from Power Bl Deskto

D. Selected required fields from the Accounts table.

E. From the Power Apps Insert menu, add a Power Bl

F. From the Power Bl Desktop menu, insert a Power Apps visual and include the required fields in the Power Apps data.

Answer: CDE

NEW QUESTION 141

- (Exam Topic 3)

You ate a Dynamics 365 Customer Engagement administrator. You create workflows to automate business processes. You need to configure a workflow to meet
the following requirements:

« Be triggered when a condition is met.

* Run immediately.

» Perform an action when a condition is met.

How should you configure the workflow? To answer, select the appropriate configuration in the answer area. NOTE: Each correct selection is worth one point.

Answer Area
Workflow Requirement Configuration Option

e —

A. Mastered
B. Not Mastered

Answer: A

Explanation:

1) Be triggered when a condition is met - Subject contains data
2) Run Immediately - Configure the workflow to run now

3) Perform an action when a condition is met - send an email

NEW QUESTION 144

- (Exam Topic 3)

You create a Power Apps portal to provide training and documentation for students. Students create a profile on the portal and then select and pay for courses.
You plan to add free courses to the training portfolio. Free courses must be automatically available to all students when they sign in.

You need to assign default permissions to students. What should you do?

A. Create an entity for managing free course

B. Create a Students web role and set the Authenticated Users role option to tru

C. Create appropriate entity permissions to access the free course entity records and assign the entity permissions to the web role.

D. Create an entity for managing free course

E. Create entity permission records to provide access to entity records for free courses and assign the entity permissions to users when they register on the portal
for the first time.

F. Create a Students web role and set the Authenticated Users Role option to tru

G. Assign the web role to each registered user.

Answer: C

NEW QUESTION 148

- (Exam Topic 3)

You have a canvas app that contains the following text input fields: Id, FirstName, LastName. The app also has a button named Buttonl.

The OnSelect property for Buttonl contains the following expression: Collect(People, {Id:Id.Text, FirstName:FirstName.Text, LastName:LastName.Text})
For each of the following statements, select Yes if the statement is true. Otherwise, select No.

NOTE: Each correct selection is worth one point.
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Statement Yes No

The People collection is automatically created if it does not already exist. O O

When Button1 is pressed, if a record with the current value of Id. Text
already exists in the People collection, the values for FirstName and ) O
LastName are updated.

If you update the record in the Collection function to iclude the value from 5
a new field named Age, it will result in an error. O O

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text, application, email Description automatically generated
Box 1: Yes

If the data source doesn't already exist, a collection is created. Box 2: No

Note: The Collect function adds records to a data source. The items to be added can be:

> A single value: The value is placed in the Value field of a new record. All other properties are left blank.
> A record: Each named property is placed in the corresponding property of a new record. All other properties are left blank.

> A table: Each record of the table is added as a separate record of the data source as described above. The table isn't added as a nested table to a record. To
do this, wrap the table in a record first.

Box 3: No Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-clear-collect-clearcollect

NEW QUESTION 149

- (Exam Topic 3)

A company uses a model-driven app. The app uses a Power Virtual Agents chatbot.

The company has two locations in different countries/regions with separate environments for each location. Each location has a development environment, a
testing environment, and a production environment. The company uses the Application Lifecycle Management (ALM) process for the environments.

You need to create the different Power Virtual Agents bot environments. How many Power Virtual Agents bot environments are required?

oowp
OO WN B

Answer: D

Explanation:

When a company uses a model-driven app that incorporates a Power Virtual Agents chatbot, and has multiple locations with different environments for each
location, it is necessary to create separate Power Virtual Agents bot environments for each location.

For each location, 3 different environments are required: development, testing, and production. This is in line with the Application Lifecycle Management (ALM)
process that the company uses.

In total, 6 Power Virtual Agents bot environments are required: 2 locations x 3 environments per location = 6. It's worth mentioning that Power Virtual Agents allows
to export and import the bot, so once you configure the bot in one environment, you can import the bot to the other environments, this way you don't need to start
from scratch.

References:

> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-lifecycle
> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/export-import

NEW QUESTION 150

- (Exam Topic 3)

You plan to create a Power Bi dataflow.

The Power Bl dataflow has the following requirements:

« Be able to create a copy of the dataflow to separate Power Bl workspaces

 Schedule the dataflow to update every day at 11:00 AW. You need to configure the dataflow.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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Answer Area

Requirement Action

Copy Power Bl datafiow. f L-!:Uu the JSOMN file '
Schedule updates

Change the settings
Change the properties
Add Streaming dataset

schedule updates, | Configure the Power Bl service v |
Refresh the history

Conhigure the Power Bl service

Share the dashboards with other users
Refresh automatically

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

Requirement
Copy Power Bl datafiow

schedule updates

Change the setings
Change the propertes
Add Streaming dataset

Schedule updates | Configure the Power Bl service - |
Refresh the histony

Conhgure the Power Bl service

Refresh automancally

NEW QUESTION 154

- (Exam Topic 3)

You are a Dynamics 365 Customer Services administrator. You have a Production instance and Sandbox instance.

Users record Production instance data in the Sandbox instance.

You need to ensure that the users only record data in the Production instance.

Which security function needs to be edited to prevent access to the Sandbox? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Application area Security function
Microsoft 365 admin center v
Roles
Groups
Licenses
Access rights
Dynamics 365 Sandbox instance v
Roles
Groups
Access rghts
A. Mastered

B. Not Mastered
Answer: A
Explanation:

Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

NEW QUESTION 159
- (Exam Topic 3)
You create a Power Platform help Desk solution.
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Leader of IT Certifications

You need to create a dashboard that displays information on help desk cases that are handled each week. Which dashboard components should you use? To

answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Requirement

Add a tag chart by using opened cases.

Add a stacked column chart shared with your team.

Add a Microsoft Power Bl visualization.

Add a chart from a view that a user creates.

Add a doughnut chart that shows cases by owner,

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Box 1: Area chart Box 2: System chart

Component type

System chart
Personal dashboard
Area chart

System chart
Personal dashboard
Area chart

System chart
Personal dashboard

Area chart

System chart
Personal dashboard
Area chart

System chart
Personal dashboard
Area chart

System charts are organization-owned charts, which makes them available to anyone with access to read the data running the app. System charts can't be

assigned or shared with specific app users.

Box 3: Personal dashboard Box 4: Personal dashboard Box 5: Area chart

Reference:

https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-

system-chart

NEW QUESTION 163
- (Exam Topic 3)
You create a new solution for a business process.

The business process includes uploading specific file types to a web service.
You need to ensure that the business process works the same way anywhere the solution is deployed. Which option should you use? To answer, drag the

appropriate options to the correct configurations. Each

option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Answer Area

Options

Connection reference

Environment variable

Solution system settings

A. Mastered
B. Not Mastered

Answer: A
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Explanation:

Box 1: Solution system settings

For Power Apps in Settings > Customizations > Customize the System you can configure email and document management, activate or deactivate processes, and
more.

Box 2: Environment variable

When should Environment variables be used? Some examples include:

When an input parameter needs to change across environments and should not be hard-coded. For example, a URL that points to a different resource in
development and production environments.

If you're building a solution where your customer is required to provide an input value. Application setup pages.

Incorrect:

A connection reference is a solution component that contains information about a connector. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/advanced-navigation https://powerapps.microsoft.com/en-us/blog/environment-variables-
available-in-preview/

NEW QUESTION 166

- (Exam Topic 3)

A company has a sales application that is supported by an Azure SQL database. You are developing a Power Apps app for use by customer service agents.
The app must reference customer data from the sales application. Data in the sales application is constantly changing and must not be replicated in Microsoft
Dataverse

Some customer data is considered sensitive. You must protect data for specific fields when users view data in the app.

You need to configure table creation for the app.

How should you configure the app? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point

Requirement Action

Dataverse table type 1o create for the

referenced customer data Create a wwiual table
Create an activity table
Create a user-owned table
Create an organization-owned table

Protect sensitive customer data for specific

fields

Create an altermate key.

Create a secured column
mplement input method editor (IME) mode
Set the value of the visible property of the fields to false

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Requirement

Dataverse table type 10 create for the
& = 5 1T * - 1 ™
reterenced cusiomer caia l Create a virtual table. |
|Create an activity table
Create a user-owned table
Create an organization-owned table

Protect sensitive customer data for specihc

Create an alternate key, _
Create a secured column. |

implement input method editor (IME) mode

fields

Sét the value of the wisible property of the helds to false,

NEW QUESTION 170

- (Exam Topic 3)

You are embedding a Power Apps visual in a Power Bl dashboard. External customers must authenticate to have access to the dashboard. You need to configure
the solution.

Which two actions should you perform? Each correct answer presents part of the solution.

NOTE: Each correct selection is worth one point.

A. Set the Power Bl service to authenticate users.

B. Use a table in the Power Bl dashboard.

C. Publish to Power Bl Report Server.

D. Set the Power Bl service to allow anonymous access.

E. Share the Power Apps visual components with external users.
Answer: AE

Explanation:
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Power Bl uses Azure Active Directory (AAD) to authenticate users who sign in to the Power Bl service, and in turn, uses the Power Bl login credentials whenever a
user attempts to access resources that require authentication. Users sign in to the Power Bl service using the email address used to establish their Power Bl
account; Power Bl uses that login email as the effective username, which is passed to resources whenever a user attempts to connect to data. The effective
username is then mapped to a User Principal Name (UPN) and resolved to the associated Windows domain account, against which authentication is applied.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-admin-power-bi-security

NEW QUESTION 172

- (Exam Topic 3)

A company creates a bot by using Power Virtual Agents.

The company requires the bot to transfer callers to an agent if the bot is unable to recognize a customers request.
You need to configure the bot for the unrecognized information from the customer. Which feature should you use?

A. Fallback workstream
B. Fallback topic

C. Fallback skill

D. Fallback queue

E. Fallback entity

Answer: B

Explanation:

A Fallback topic is a type of topic in Power Virtual Agents that is used when the bot is unable to understand the customer's request. When a Fallback topic is
triggered, it takes over the conversation and presents the customer with a set of options or a message that allows them to get the help they need. This can include
options such as requesting to speak with an agent, providing feedback, or getting more information about the bot's capabilities. Fallback topic can be configured to
automatically transfer the customer to an agent.

References:

> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/fallback
> https://docs.microsoft.com/en-us/power-virtual-agents/create-bot/bot-topics

NEW QUESTION 176

- (Exam Topic 3)

You are a Dynamics 365 Sales administrator for a software company. The sales team wants to attach a large number of supporting documents to customer
records, but management does not want to incur the cost of additional storage.

The company does not have any Office 365 application integrations enabled. You need to recommend a storage solution that keeps storage costs low. Solution:
Enable server-based SharePoint integration.

Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:
References:
https://docs.microsoft.com/en-us/power-platform/admin/set-up-dynamics-365-online-to-use-sharepoint-online

NEW QUESTION 180

- (Exam Topic 3)

You are designing a Power Virtual Agents chatbot for a store.

You need to teach the chatbot to acknowledge the store's product categories and the variations within specific categories.

You need to create custom entities to provide the chatbot with the knowledge of the product categories. Which features should you use? To answer, select the
appropriate options in the answer area.

NOTE: Each correct selection is worth one point.

Answer Area
Requirement Feature
Analyze misspellings, grammar variations, and semantic Slot filling
Synonyms
Smart matching
Topics
Fuzzy matching
yarations. i : -
KRSk HiE bot smarter by expanding the matching logic.  [siot filling
Synanyms
Topics
Extract a category selected by a user during a conversation 7
: : 4 4 Stot filling
t i ] F
into a variable for later use, Synonyms
Smart matching
Topics
A. Mastered

B. Not Mastered
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Answer: A
Explanation:

Smart match Synonyms Topic
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 184

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer
interactions with employees. The app uses standard table types for customers. A user named Elisabeth Rice signs in to the app by using the following sign in
name: Elisabeth.Rice@contoso.com.

After marriage, Elisabeth changes her legal name to Elisabeth Mueller.

You need to update the sign in name for the user without losing any application history.

Solution: Ask the Microsoft 365 administrator to sign in to the admin portal and change the username. Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 185

- (Exam Topic 3)

You have a business process flow (BPF) that interacts with the Account entity. You configure a new version for the BPF and add a new stage at the beginning.
You need to identify the impact of the new version on the existing account records.

What is the outcome in each scenario? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Scenario Action

What happens to existing accounts? v

Existing accounts show the old BPF
Existing accounts show the new BPF.

Existing accounts only show the new stage

What happens to new accounts? v

No BPF is linked to a new account,
The new BPF shows only the new stage for a new account.

The new BPF 1s showing in a new account.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Graphical user interface, text Description automatically generated

Box 1: Existing accounts show the new BPF.

When an entity record is being created and if there are multiple BPFs defined on that entity. The system would do the following:

If the Processld field is set to Guid.Empty. The system will skip defaulting the BPF on that instance.

If the Processld field is set to specific BPF entity reference. The system will default to the specified BPF. If the Processld field on the record is not set. The system
will default the BPF.

Box 2: No BPF is linked to a new account.

Note: A business process flow definition is represented as a custom entity and an instance of a process is stored as a record within that entity. Each record is
associated with a data record (such as an Account, Contact, Lead, or Opportunity) and in case of cross-entity processes, with a data record for each participating
entity.

Reference:

https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/business-process-fl

NEW QUESTION 188

- (Exam Topic 3)

A company is developing several Power Virtual Agents chatbots. The company manufactures more than 1,000 different products.
The chatbots must prompt users to enter or select a product.

You need to store the model information so that it can be reused across all chatbots. Where should you store the model data?

A. Global variables

B. Custom entities

C. Topics

D. Multiple choice options

Answer: A
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NEW QUESTION 193

- (Exam Topic 3)

A company uses a model driven app.

The company needs to automatically update the Status column in real time. You need to configure this feature.
Solution: Create a flow that has an Update a row action. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 196

- (Exam Topic 3)

A company has a model-driven app.

The app must meet the following requirements:

* Prevent users from saving a record if validation from a custom action fails.

* Query and update a list of records.

You need to configure processes for the app without using code.

Which processes should you use? To answer, drag the appropriate processes to the correct requirements. Each process may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Processes Answer Area
[~ d Ao »
LK T Requirement Process
assic workflow Prevent users from saving a record
Query and update reconds.
Business process flow
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Processes Answer Area

Requirement Process

Frevent users from saving a recond

NEW QUESTION 197

- (Exam Topic 3)

You are creating Power Bl reports for a company.

A company that has a model-driven app wants to use Power Bl reports within the app. You create the reports. You need to ensure that these reports are available
within the app.

Which two actions should you perform? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. Share the Power Bl report to all users.

B. Add the Power Bl report to the Site Map dashboards.

C. Create a PCF file.

D. Use the native reports in model-driven apps.

E. Add the Power Bl report to a dashboard in the model-driven app.

Answer: BE

Explanation:
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/add-powerbi-visual

NEW QUESTION 198

- (Exam Topic 3)

A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity
to streamline the prospect management process.

You add a field named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records
based on the selected category. Users can switch to any other newly configured business process flows but must not use BPFA.

You need to configure the solution.

What are two possible ways to achieve this goal? Each correct answer presents a complete solution. NOTE Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.

B. Deactivate BPFA.

C. Use a business rule to prevent users from switching to BPFA.

D. Change the display order of the business process flows to move BPFA to the bottom of the list.
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Answer: AB

NEW QUESTION 199

- (Exam Topic 3)

A company is implementing a data model by using Dataverse.

The company requires the following columns in a new custom table:

Column name Requirement

Special Notes Must contain string data that stores 100 characters and be rendered as a multihne control.
Specilication Must contain string data that stores up to 8,000 characters and be rendered as a multiline contrel
Student

Must contain an input control that can store a reference ta an account or a contact in the system

Course Type

Must contain a list of predefined options. Users musl be able to select only one oplion

You need to choose the column type that uses the least amount of database storage for each column.

Which column types should you choose? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Column name Column type

Special Notes | Multiline Text

32!

leat

[ext Area

Multiline Text
Specification ] Multiline Text 1'3

Text

lext Area
Multiline Text

Student I Loakup "

Choices
Customer
Lookup

Course [ype Choice

Choiges
Lookup

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Answer Area

Column name Column type
Special Notes l Multihne Text %

lext
Text Araa
_Muililim Text

Specification | Multiline Text w

Text
[ext Area
Student | Lo kup )
Chioices
13
Course lype I Choice

LTI ES

Lookup

NEW QUESTION 200
- (Exam Topic 3)
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Leader of IT Certifications

Your organization does not permit the use of custom code for solutions. You need to create a view that can be viewed by all users in an organization. Where

should you create the view?

A. Microsoft Visual Studio
B. Maker portal

C. Advanced Find

D. System Settings

Answer: B

Explanation:
Reference:

https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-views-app-designer

NEW QUESTION 201
- (Exam Topic 3)

A company'’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.

You need to provide a solution for each requirement.

Which solutions should you provide? To answer, select the appropriate options in the answer area.

NOTE: Each correct selection is worth one point.
Requirement

Drag and drop opportunities to change the stage

Show each salesperson their opportunities in

Solution
-
Add a Kanban control
Add a Timelne control
Add an Editable Gnd control
Add a Calendar control
-

Calendar and Kanban view

Show each salesperson the number of open

Add both controls to a custom view

Add both controls to the My Opportun
Add one control to All Opportunities and a custom view
Add one control to My Opportunities and a custom view

es wiew

-

opportuniies by stage in a standard view

use the cnart pane on the view

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Use the List view
Use the Timeline control

Use the Kanban control

Graphical user interface, text, application, email Description automatically generated

Box 1: Add a Kanban control.

The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.

Box 2: Add both controls to the My Opportunities view.

> Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so
salespeople can use the Kanban views.The Kanban control works only on the Opportunity and Activity entities.

> If you use unified interface, you can display any record in a calendar view via the calendar control.

- Go to Settings->Customization->Customize the System

- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example)

- Click the View tab
- Click “Add Control” and select the calendar control.

- Click the dot for every interface from which you want the calendar control to be available.

Box 3: Use a List view
opportunities in Dynamics 365 Sales
Reference:

https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wavel/dynamics365-sales/work-opportunities- https://crmtipoftheday.com/1206/view-any-

dynamics-365-record-on-a-calendar/

https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-cod

NEW QUESTION 202
- (Exam Topic 3)

A company is implementing Power Apps and Power Automate.
Several components are created within Power Apps. Microsoft Dataverse. and Power Automate. These components must be promoted from the development
environment to the user acceptance test environment in a single solution package.

You need to create the solution package for promotion. Where should you create the package?

A. Office 365 admin center
B. Azure DevOps
C. Power Apps designer
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D. Microsoft Power Platform admin center
E. Azure portal

Answer: D

Explanation:

A solution package is a bundle of components, such as Power Apps, Power Automate, and Microsoft Dataverse, that can be promoted from one environment to
another. To create the solution package for promotion in a company that is implementing Power Apps and Power Automate, the package should be created in the
Microsoft Power Platform admin center.

In the Power Platform admin center, you can create a solution package that includes the necessary components and export it as a .zip file. This file can then be
imported into the desired environment, such as the user acceptance test environment, to promote the components.

References:

> https://docs.microsoft.com/en-us/power-platform/admin/solutions/create-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/import-solution
> https://docs.microsoft.com/en-us/power-platform/admin/solutions/export-solution

NEW QUESTION 205

- (Exam Topic 3)

A company has a model-driven app that uses Microsoft Dataverse.

Users need to add an alternate phone number when entering their account information. The users also require a list that displays the customers that do not have
an alternate phone number.

You need to enable the required features.

Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at
all. You may need to drag the split bar between panes or

scroll to view content.

Features Answer Area
abie Requirement Feature
e Add altemate phone number
List of customers without altemate
Colum phone number
:.r_';_-.'. na 0 .
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Features Answer Area
o Requirement Feature
" Col
= Add altemate phone number | ; |
List of customers without alternate R VIEW I
im phone number

NEW QUESTION 207

- (Exam Topic 3)

A user needs to create a Power Apps portal app.

The user is getting a permission denied error when creating the portal app.

You need to configure permissions to create the portal app.

Which three permissions should you configure? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. In the Power Platform admin center, ensure that the user account has read-write access.

B. In Azure Active Directory, assign the Contributor role to the application at the subscription scope.

C. In Azure Active Directory, ensure that the user has permission to register an app.

D. In the Power Platform admin center, change the portal app owner to the user.

E. In the Power Platform admin center, ensure that the user has the System administrator security role.

Answer: ACE
Explanation:
Reference: https://docs.microsoft.com/en-us/power-apps/maker/portals/create-common-problems https://docs.microsoft.com/en-us/power-

apps/maker/portals/create-portal
https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-create-service-principal-portal#required
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NEW QUESTION 212

- (Exam Topic 3)

You create a canvas app.

The app requires access to data that is stored in collections. The app must provide the following actions:

* Create a new collection variable.

* Remove table values from a collection. You need to configure functions for the app.

Which functions should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Answer Area
Action Function
Create a new collection vanable | Collect -
St
Gelect
Collect
AddColumns
Hemove table values from a collection I Clear '
Heset
:it"'hf”
DropColumns
A. Mastered
B. Not Mastered
Answer: A
Explanation:
Answer Area
Action Function
Create a new collection vanable [ Cotect -
Set
|
Acal olumns

Remove table values from a collection bt

T
L
A

o I )
U |
1.
—

ropColumin:

NEW QUESTION 217
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